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TrackRanger is a comprehensive dynamic navigation 
system. For best results, the new user should become 
familiar with this quick start guide before using 
TrackRanger. 
 

Installing TrackRanger 
Insert the TrackRanger CDROM into the Notebook PC 

 

The Installa�on program should automa�cally launch. If Auto Insert No�fica�on 

is disabled for the computer, you will need to manually launch SETUP.EXE on 

the CDROM. Do this by naviga�ng to the CDROM drive from My Computer or 

Windows Explorer, and double click on the file SETUP.EXE. 

 

It is recommended that all of the TrackRanger Installa�on “default se-ngs” be 

followed.  

 

Setup will create the necessary directories; copy all of required files, including 

the demonstra�on maps, establish the necessary desktop and start menu items 

shortcuts and op�onally allow the user to install Acrobat Reader. 

 

 

Acrobat Reader is required to view the online manual and other associ-

ated documents. Most systems have Adobe already installed. Adobe PDF 

reader is available from: h4p://www.adobe.com/products/ 

 
TrackRanger-PRO 
 
GPS Navigation System 
 
Version Pro-7 

  
 
Installation Instructions  
and 
Quick Start Guide 
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Please note:  

TrackRanger comes with a single user licence. As part of the instal-

la�on, this licence will be installed as a serial number onto the us-

er’s computer. This should be the computer (i.e. Notebook/Laptop) 

on which TrackRanger will be used 

in the field  

 

To find the serial number, start 

TrackRanger, the licence is the Seri-

al Number found under the 

TrackRanger > Help drop-down 

menu > Register TrackRanger.  

 

 

The user will be prompted to forward this serial number to Advan-

tech Design for registra�on processing.  

 

TrackRanger may be installed on mul�ple computer systems, and 

most func�onality will work on these other computer systems. 

Please only request a registra�on for the computer that you will 

use TrackRanger with in the field. (See page 22 for more infor-

ma�on).  

TrackRanger opera�on overview  

Start TrackRanger from the Start | Programs | 

TrackRanger menu, or by double clicking on the 

TrackRanger icon on the desktop. 

 

Sample GPS Data:  

TrackRanger has an embedded sample GPS data file that allows a 

user to become familiar with TrackRanger’s powerful features 

without requiring the user to ac�vely navigate. TrackRanger in-

cludes a demonstra�on facility, allowing the user to quickly view 

some of TrackRanger’s powerful naviga�on features. 
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Start TrackRanger. Select Run 

TrackRanger Demonstra�on from the 

help drop-down menu: 

  

 

 

 

 

 

 

 

Follow the prompts, and TrackRanger will automa�cally load maps, 

Waypoints etc, and start naviga�ng for you using it’s internal naviga-

�on features. This includes On-screen messages and Voice prompts 

 

Alterna�vely, you may manually connect (Link) to the demonstra�on GPS 

data, and load a map by following these steps: 

Step 1: With TrackRanger running, press the Escape <Esc> key on the 

keyboard. Click Yes to link to the GPS demo data. TrackRanger now 

works as though it were actually connected to a real GPS unit, allowing 

all of the func�onality. Note: When TrackRanger is connected to a live 

GPS unit, press the L (Link/Listen to GPS) key instead. 

 

Step 2: Press the ‘M’ key. TrackRanger will search for maps that match 

the GPS posi�on. Use the down/up arrow keys to navigate to the map 

named:  

TrackRangerSampleMap_HighRes.jpg from the list, and then press enter 

to load the map. 

 

Step 3: Where the actual map size is larger than the computer screen, 

Auto-Map-Move is the most suitable. To start this func�on, press the ‘A’ 

and then the ‘M’ keys on the keyboard. No�ce that the map moves in 

the background while the current GPS posi�on tends to remain ‘towards’ 

the centre of the map display screen. 
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Step 4: Experiment with Hot-Keys: 

Press the G key to toggle the GPS data display 

Press the C key to toggle the Compass display 

Press the S key to toggle the Speedometer display 

Press the D key to toggle the Distances to Waypoints display 

Press the R key to toggle the Scale Ruler display 

 

If Waypoints are loaded, press the space bar to show / hide the marker and 

Waypoint names. See also the sec�on on Waypoint Management Func�ons 

(page 23), and in the online help. 

 

For best results, Advantech Design recommends you do the following: 

• Copy Natmap Digital maps (if purchased) to the Hard Disk Drive 

 (see page 10 of this guide). 

• AGer copying Digital Maps, select “Update Database for all  

 recommended maps” from the U�li�es drop-down menu. 

• Check “Load next ECW Map before Boundary Reached” from the U�li-

�es drop-down menu (the default op�on). 

• Install the UBD maps (if purchased) using all default se-ngs, including 

allowing the install program to copy maps to hard drive. 

• Set the GPS Com Port to match the Com port used by the GPS Receiver 

on your laptop (Control-S or View > GPS Satellite data) see Pg 21. 

• Make sure your GPS Interface is set to NMEA (see page 21) (Not re-

quired for the TrackRanger GPS). 

 

For normal opera�on, the easiest way to use TrackRanger is to Press L to 

Link to the GPS, then press AP to start Auto-Pilot—In Auto Pilot, TrackRanger 

finds the best map available for your current posi�on) 

 

Note: The AM key combina�on will toggle the state of the Auto-Map-Move 

func�on. 

 

The Z key can be pressed at any �me to zoom out to normal size (100% mag-

nifica�on), or to refresh the screen. 
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Adding a Photo Image or Video Clip to a Waypoint 
Position 
(See further informa�on on Waypoints on page 23) 

 

It is possible to add a photograph or Video Clip to a Waypoint 

Posi�on.  This is a useful way to keep track of loca�ons, fishing 

spots, camping area, or other points of interest. The image can 

be either JPG or BMP format, or MPG video clip.  

 

Add the Waypoint to the map (right click on map at desired posi-

�on, or press the keyboard + key to instantly add a Waypoint at 

the current GPS posi�on—Valid GPS data must be received), and 

Showing the Photo Image on the map 
Simply move the mouse over any Waypoint  with 

an associated image and 

press the leG mouse 

bu4on. The image will be 

displayed. Clicking on ad-

di�onal Waypoints will 

cause their associated im-

ages to be shown. Clicking 

on the same Waypoint 

again will hide the image 

display. When the image 

is shown, the cap�on of 

the marker is superim-
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Using TrackRanger with Natmap Digital (ECW) maps 
(refer also Copying Natmaps Section on Pg 10) 
The user should first familiarise themselves with the opera�on of 

the Natmap Digital Viewer Map Reading program, and the associat-

ed controls and tools. Most of these op�ons are also available from 

within TrackRanger. 

 

Note that most Hot-Key commands associated with Natmap maps 

begin with E. This is derived from the file type of ECW (Enhanced 

Compressed Wavelet format) 

 

Naming the ECW files directory: 

TrackRanger will a4empt to automa�cally find the loca�on of the 

Natmap Raster maps whenever the user a4empts to load one of 

these maps. If TrackRanger cannot locate the maps, it will prompt 

the user to search for the 250k.ECW files.  

 

If Natmap maps are copied to the hard disk drive, please run the 

Natmaps Raster Viewer program first, before star�ng TrackRanger. 

This will ensure that the file loca�ons are prepared for 

TrackRanger, and save the user having to manually search for 

them. 
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Raster & UBD Street Map Loading op�ons: 

There are two different map-loading op�ons:  

Tip: When an ECW (e.g. Natmap Digital Maps) map has been loaded, and 

is ready for internal use by TrackRanger, the small Tick bu4on may also 

be pressed to load the current ECW view into TrackRanger. (Note: Hot-

Key func- �ons 

may not work 

when in preview 

mode) 

 

Op�on 1: Natmap Digital/Mosaic & UBD: 

TrackRanger supports Auto-Pilot with Natmap Raster and UBD Street Di-

rectory maps. Just press L to Link to the GPS, and then use the hot-keys 

AP to turn on Auto-Pilot. TrackRanger will find and load the associated 

map, con�nue to Auto-recommend and Load further maps, and enable 

Auto-Map-Move all in one opera�on. 
(note: refer to GPS NMEA communica�ons setup on page 21)  

A;er loading, Press hot keys X1—X8 to change the zoom when navi-

ga�ng with GPS data (X9 for User defined Zoom—set from u�li�es 

menu) 
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Op�on 2: Load any map: 

To open any map, select the Open Map from the Files drop 

down menu. (Hot-key O) 

Note that manual loading of the UBD Maps is undertaken 

from the UBD map u�li�es drop-down menu (see page 25 for 

more informa�on). 

Manually load UBD maps from the 

drop-down menu (City Streets or 

Regional Towns) 



9 

Using the ECW map: 

Note that for op�ons 1 & 2, TrackRanger 

will allow the loaded ECW map to be 

used for normal posi�oning purposes, 

but the map load must be finalised be-

fore other TrackRanger func�ons, such as 

distance measurement, marker posi�on-

ing, Waypoints etc can be used. 

 

If these addi�onal features are required, 

once the desired ECW map has been 

loaded, simply press the Red Tick. This 

will then finalise the import of the map so that other features are 

available. 
 

Revert back to preview mode with the far-right bu4on on the mini toolbar: 
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Installing Natmap Digital maps to the Hard Drive  

Important!!!! Skip this sec�on if you have received Natmap 250k as part of 

the TrackRanger package deal—no install is necessary, just copy the maps 

as shown below in the sec�on: “Copying Natmap from DVD/USB to hard 

drive”  
 

If Natmaps is not already installed, install Natmaps by clicking on SET-

UP.exe from the top-level directory on DVD Disc 1. Refer to inside front 

cover of Natmaps CD case.  Make sure TrackRanger has been fully in-

stalled before commencing this copy procedure. (Tip: When installing 

the actual Natmaps product, we recommend that you use the  

TYPICAL install op�on) 

__________________________________________________________ 

 

 

Copying Natmap from DVD/USB to hard drive 

TrackRanger supplies an automa�c u�lity to copy the map files. To use,  

do either of the following: 

 

A: Run Setup.exe directly from the Natmap Digital DVD disk. 

 

or 

 

B: click on the U�lity to Install Natmaps To HDD program  icon from 

Windows Start > Programs > TrackRanger. 

 

 

 

 

 

 

 

 

The steps to follow are described below. You may also follow the on 

screen instruc�ons that are presented by the program. 
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For Natmaps Digital Insert Disc 1 into the CDROM / DVD Drive  (or 

insert USB drive if products purchased on USB) 

 

 

 

 

 

 

 

Answer the ques�on on the 

map type you are copying 

from (Digital Maps, MOSAIC 

Premium,  Standard, MAP-

SHEETS etc) 

 
(Tip: Please also review Manual Find op�on on page 12) 

 

Follow the prompts of the program depending on the product  

you are installing (�p: select ‘NATMAP Digital Maps’ for distribu�ons 

supplied on USB removable drives).  

The program will automa�cally select the loca�on of the file 

250k.ecw  (if installing from a USB flash drive, refer to informa�on 

on page 12, using the Manual Install method) 

 

Press the “Select Maps Des�na�on” bu4on. We recommend that you 

use the defaults as selected by the program for your computer. 
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You may also press the Manual Find bu4on if nec-

essary and navigate to this loca�on on the DVD or 

USB drive (op�onal purchase).  

 

You need to locate the file ‘250k.ecw’ in a sub-folder of the Natmap 

Disk 

 

 

 

 

 

 

 

 

 

 

 

 

 

Press the Copy the Map Files bu4on. 

 

Wait un�l the 250k.ecw Map has been 

copied from the DVD / USB Drive. This 

will take several minutes. 

 

Press Close.  

 

 

Note: If you have Natmap Digital 2008 or Natmap Raster Premium, 

DVD-2 is not required for TrackRanger opera�on. 

 

Your Maps are now available from your hard disk drive, and all relat-

ed updates have been made to the computer.  
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Erra�c Mouse Move Problems with GPS units 

If, aGer star�ng your computer with the GPS connected, the 

mouse cursor movements are erra�c / uncontrollable, please re-

start the computer with the GPS disconnected / switched off. This 

problem occurs because if the computer is started while the GPS is 

connected (regardless of TrackRanger opera�on), the opera�ng 

system incorrectly detects the incoming GPS messages as mouse 

movements, and assigns the mouse drivers to the communica�ons 

port. Incoming GPS message packets are incorrectly interpreted as 

mouse movements, resul�ng in erra�c screen mouse posi�on da-

ta. Star�ng / connec�ng the GPS aGer the opera�ng system has 

completely started overcomes this problem. Please note: this is 

not a TrackRanger problem. It occurs before TrackRanger is start-

ed. It is a result of incorrect interpreta�on by the Windows Oper-

a�ng System of the received GPS data as mouse movement com-

mands. 

 

Installing Products from the USB removable drive (op�onal pur-

chase) 

TrackRanger:  Open the TrackRanger folder on the USB drive. Dou-

ble-click on Setup.exe.  Allow the program to run if requested to 

confirm. Use the default recommended se-ngs. 

 

UBD: Installing UBD City streets from the USB drive: Open the  

UDBCityStreets  or UBDRegionalCi�esAndTowns folder and dou-

ble-click on the SETUP.exe file. Allow the program to run if re-

quested to confirm. Only use the default loca�ons as recommend-

ed by the program. TrackRanger will find and use the UBD product 

aGer the next restart. 

 

Natmap: Refer Page 10 ‘Copying Natmap from DVD/USB to hard 

drive’ 
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Advanced features: User supplied maps: 

 

Map Calibra�on of User Supplied (scanned) Maps 

 

Although TrackRanger works with pre-calibrated maps, some users have 

their own paper maps that they may import into TrackRanger aGer scan-

ning on a PC scanner. This feature is par�cularly useful for gold prospec-

tor’s own favorite maps, etc. 

 

(Tip: TrackRanger version 3.2 or later can automa�cally read ECW for-

mat maps direct from disk (e.g. Natmap Maps). These maps are already 

calibrated. The following sec�on is only provided to assist users who 

wish to calibrate their own scanned maps (i.e. not Natmap). ) 

 

TrackRanger also comes with a demonstra�on map that has not been 

calibrated. This allows the user to prac�ce using TrackRanger’s powerful 

tools to calibrate the map. 

 

Press the keyboard ‘O’ key to open any map. Navigate to the file named 

TrackRangerUserSetupMap_HighRes.jpg  

(Note, a low-resolu�on version is also available for systems with lower 

resources, less memory, lower CPU power etc. If you have difficulty 

loading the HighRes image on your system, please use the 

TrackRangerUserSetupMap_LowRes.jpg image instead). 

Open this map. No�ce that the message ‘Map Not Calibrated’ is pre-

sented in the Map Display data sec�on of the GPS coordinates window 

(hot key G). 

 

TrackRanger will also advise the user that a new calibra�on file will be 

created for this map, with a message similar to the following: 
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Calibra�ng the map involves the following easy steps: 

1. Posi�on the mouse over a known loca�on near the upper leG 

hand corner of the map (e.g. a grid line intersec�on). 

 

2. Press and hold the <Ctrl> key on the keyboard, and press the Le; 

Mouse BuIon. 
 

If the mouse was not within the map surface, the Cursor Start Point 

would be shown in Red. In this case, simply press cancel, and repeat 

from step 1 again. 

Press the topmost  bu4on 

     

 

If the value is in UTM coordinates, press the Enter as UTM Coords 

bu4on and enter the Northing/Eas�ng and map zone. For the sam-

ple map, enter the UTM values shown above. 

 

3. Click on Calculate and then Accept. 
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4. Press the  bu4on. 

(You may ignore any Horizontal Distance warning messages at 

this stage, or informa�on rela�ng to ruler calibra�on)  This data 

is input in step 10. 

 

5. Now, move the mouse to the lower right-hand corner of the 

map (use the scroll bars or arrow keys on the keyboard to 

move the map) and with the mouse in the posi�on as shown 

below, hold down the <Alt> key, press the leG mouse bu4on. 

(Note: this is NOT the Control key, but the ALT key!). The Lat 

Long and Distance data form is again presented. 

6. Press the lower  bu4on, enter the fol-

lowing values, then press the Calculate and Accept bu4ons. 

  

7. Press the  bu4on 

8. Press the  bu4on 

9. Press the  bu4on 

10. Press the  bu4on 

11. Press the  bu4on, and the map is now calibrat-

ed. 
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No�ce that the La�tude and Longitude scales are now automa�cal-

ly drawn alongside the map. 

 

Note: You may need to select an alterna�ve World Geode�c Sys-

tem (WGS) for other maps. Check the map legend to find out which 

WGS the map conforms to. This is required for the UTM coordi-

nates only. 

 

Press the <Esc> key to reload the GPS data. The GPS posi�on is 

now drawn on the calibrated map surface. 

 

Press the ‘M’ (Map recommenda�on) key, and no�ce that the 

newly calibrated map is now provided in the list of maps! 

 

Press AM to enable Auto Map move 

 

A series of scanned map ‘frames’ scanned from a larger map may 

also be easily calibrated using the Quick Lat/Long Calculator. See 

the TrackRanger manual and the online help for more details. 

 

Scanning a map 

The following guidelines are presented as recommenda�ons for 

the preferred resolu�on and sizes etc for scanning of maps: 

 

If your scanner soGware supports these features, set as follows, or 

at least as close as possible: 

Resolu�on:  

100 dpi or greater (200dpi recommended for high res.) 

Document type: Photo quality (Photo Quality 24 bits) 

Scale: 100% 

Scan Mode: Color 

Auto Density 
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Scan the informa�on, and save as a JPG (preferred), PNG or BMP 

file. Tip: When scanning mul�ple frames from a larger map, give 

each frame a suitable name to iden�fy it e.g. MyMap1_a.jpg, 

MyMap1_b.jpg etc 

 

Once the map has been created, it should be saved to the 

TrackRanger Maps directory  

(usually C:\Program Files\TrackRanger\Maps\)  

on the TrackRanger computer system. Alterna�vely, it may be 

wri4en to a CD-ROM, as a part of a user defined library of maps for 

use by the TrackRanger system. 

 

Determine the start and end Lat/Long coordinates of the map im-

age, then load the image into TrackRanger (hot key ‘O’ to open 

map dialog), and calibrate the map as per the details in sec�on 3 of 

this guide. 

 

For more informa�on, please refer to the sec�on “Se-ng up a 

map” in the TrackRanger_Manual.pdf, and also the TrackRanger 

Scanning Maps Guide.pdf files, both of which are available from 

the Windows Start | Programs | TrackRanger menu on your Note-

book computer  

 

Zoom out using the keyboard Z key, or from the pop-up menu sup-

plied by clicking the right mouse bu4on while the mouse cursor is 

posi�oned over the map. 

Note that you must zoom out before zooming in on a different 

loca�on of the map. 

 

GazeIeer Place Name Search: Press <Alt>G or select Gaze4eer 

from the View drop-down menu. Enter one or more le4ers describ-

ing the loca�on, press Search, double-click any item to add as a 

Waypoint. Use filter by Search Type and Loca�on (state) if re-

quired. Sort results by clicking on the column heading. 
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Error Messages: 

TrackRanger may give an ‘Unable to show Toolbar’ or other error 

message when opening an ECW (e.g. Natmap) map, or advises that 

a Waypoint file is invalid, or does not store the registra�on correct-

ly etc.  This can occur if TrackRanger is not running with correct 

privileges. Vista and Windows 7 can cause this if User Authorisa-

�on Control (UAC) is set too high. There are two known ways to 

overcome: 

 

1: Right-click on TrackRanger 

and select: 

Run As Administrator 
 

or  

 

2: Change UAC control se-ngs from:   

Windows > Control Panel > System and Security > Ac�on Center 
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Measure a Distance 

There are several ways to measure distances with TrackRanger. 

1: Right-click on the map and select Set Distance origin. Move 

around the road network, leG-clicking at each junc�on. 

The accumulated distance is displayed.  

Right-click to end the sequence 

 

 

 

 

 

2: 

With 

Auto-

Map Move disabled, move the mouse to a posi�on on the map, 

press and hold the leG <Shi;> key, and leG-click and move the 

mouse to follow a road contour. Release the mouse bu4on and 

view the contour and straight-line distances. 

 
 

3: Control-D can also be used to assist with ‘accumula�ng’ a dis-

tance from mul�ple single distance measurements. See the Help 

file for more informa�on 

 

TrackRanger Manual 

The TrackRanger online manual is available from the Windows 

Start Menu > Programs > TrackRanger start menu item. Extensive 

online help is also available from the Help menu from within 

TrackRanger. 
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GPS communica�ons 
Before TrackRanger can be used with a GPS unit, the communica�ons must be set 

to match the data being sent from the GPS unit. This is quite a straigh^orward 

process. 

 

From the Satellite display (View Menu or hot-key Control-S), select the “GPS 

Comms” tab, and set up the values to match your GPS. Generally, the values as 

shown to the right will be correct except for COM port number. You can auto-

ma�cally detect the COM number by pressing the bu4on shown.  (You MUST 

have the GPS drivers loaded and the GPS connected first before Auto-detect 

will work) 

 

Refer to the documenta�on that came 

with your GPS for determining the COM 

port number. Press ‘L’ to Link to the GPS 

unit.   

 

The status of GPS communica�ons is al-

ways available from the status window on 

the GPS coordinates form (hot-key G).  

On your GPS, (SETUP | INTERFACE menu) 

the Interface should be NMEA (highest 

revision available). TrackRanger will not 

be able to receive data unless the NMEA 

interface is selected on your GPS unit.  

The datum should be WGS84 for NatMap 

maps. (These se;ngs are not required 

for the TrackRanger supplied GPS) 

(Note that Link command on the Demo 

version Links to the sample GPS data instead.) 

 
Windows 7 GPS Driver: A copy of this driver is included on the TrackRanger CD. 
Unplug the GPS.  
Insert the TrackRanger distribution CD, Cancel Install if it tries to run, Using Com-
puter, navigate to and open the Windows7_TrackRanger_GPSDriver folder on 
the CD/DVD drive.  
 
Launch the 
PL2303_Window_7_Driver program: 
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Registra�on of So;ware  

TrackRanger soGware must be registered to con�nue to run as a full GPS ca-

pable version. TrackRanger will work on any compa�ble PC, but some GPS 

func�onality is limited aGer an ini�al period un�l the soGware is registered 

on the (notebook) computer that TrackRanger will ul�mately operate on. 

 

The licence allows you to only register TrackRanger on one computer. With 

the soGware installed on the desired computer system (usually a notebook 

or other portable PC), select Help | Register TrackRanger from the main 

menu bar. 

 

Copy the details provided, together with name and address informa�on, and 

post to Advantech Design. Alterna�vely, you can send the details by email to 

trackranger@advantechdesign.com.au 

 

If your laptop has email access, just press the “Send Serial Number by Email” 

bu4on 

 

You will shortly receive a registra�on code by return mail / email. To install 

the registra�on, click on Help | Register TrackRanger, and enter the registra-

�on number provided. 

 

Full details of the installa�on procedure are provided with the returned reg-

istra�on number. Registering ensures that all of the features of the 

TrackRanger soGware remain fully opera�onal. 
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Track Trace (recording you travelled path) 

* Press the <Esc> key to reload the GPS data.  

* Press M to find a map if required, and reload. 

* Press A M to turn on Auto-Map Move if desired. 

* With a GPS posi�on on screen, press the T key to start Track-

Trace. TrackRanger will provide you with a recommended name to 

use for this individual Track Trace. Watch as TrackRanger records 

the journey. 

* Experiment with Track Trace colours, TrackTrace resolu�on etc 

from the U�li�es menu. 

* Press the T key again to disable TrackTrace. 

* AGer a Track Trace has been recorded to disk, press the P key to 

select and load in a TrackTrace file and plot the TrackTrace directly 

to the map surface (these op�ons are also all available from the 

U�li�es menu) 

* Note that Track Trace and plots are influenced by Datum ShiG—

see the TrackRanger manual sec�ons 12 and 19 for more detail. 

 

Waypoint Management func�ons 

See TrackRanger Help for seMng the GPS communica�ons proto-

col to suit Waypoints if you are uploading/downloading from a 

GPS. (Tip: Some GPS units require the NMEA output to be 

switched off prior to uploading/downloading Waypoint data.) 

1.From the main screen, press Control-W (or select Way-

points/Routes management from the View drop-down menu). 

2.Press the “Load Waypoints from file” bu4on, and select and 

open the .WPT file. 

Check the Show Waypoints / Routes on map checkbox. 

TrackRanger will give Voice alerts if ‘Alert as Approach WP’s is 

checked. See Sec�ons 7 & 8 of the TrackRanger Manual 
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Click on OK, and no�ce that the Waypoints and route markers are 

now displayed on the map surface (you may need to scroll the map 

with the arrow keys to view the points data). Move the mouse over 

one of the points, and the name, Lat/Long and comment is dis-

played. 

 

Photos or Movies can be added to Waypoints by right-clicking the 

Waypoint! 

 

When Waypoints are loaded, Distances and ETA’s to Waypoints 

may be displayed by pressing the hot-Key ‘D’. 

 

Refer to sec�on 7 & 8 of the TrackRanger manual for more details. 

Press the space bar and no�ce that all of the names are displayed 

simultaneously. 

Waypoints and routes may be up/down loaded from most GPS 
units. This allows you to create and save any number of Waypoints, 
and load them back to your GPS when required. Some GPS units  
require that NMEA be switched off to upload/download Waypoints.  
 
Refer to your GPS user documentation for information on changing 
communication protocols.  
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UBD Maps: 

UBD maps will autoload with the AP (AutoPilot) hot-key command. Search 

for Streets, Suburbs or Facili�es directly from the UBD drop-down menu at 

the top of the TrackRanger screen. 

 

For full detailed informa�on, see Sec�on 27 of the TrackRanger Manual 

(pdf file). 

Note: If you have installed UBD Australian Regional Ci�es and Towns V3.0 

or later, you must ini�ally select Update Database from the TrackRanger 

U�li�es drop-down menu so that TrackRanger can learn about these maps. 

 

Selec�ng Map Region Choose the desired map region from the drop-down 

list at the bo4om of the UBD maps page: 

 
Select the Suburb and double-click to load: 

 

Finding Facili�es 

Scroll through the list of avail-

able facili�es for that map re-

gion, and double-click to se-

lect the desired facility type, 

double click to load: 
 

Tip: When UBD Capital Ci�es map loaded, use keyboard Shi; + Arrow keys to 

zoom to an adjacent map region (not for Regional Towns maps) 

Tip: The keyboard ‘U’ key toggles between 1:20K and 1:40K UBD 

maps on the Capital Ci�es maps. 
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TrackRanger Hot Key Summary: 

Please note: the Hot-Keys do not work with Natmap maps when they are in manual 

Preview mode. Use the commands from the drop 

down menus when in this mode (i.e. with this toolbar 

showing)  

  A2-A5  Auto-Track Zoom magnifica�on 2X-5X (see    

  also X1, X2, X3) (use X1-X7 for NatMaps, UBD etc) 

  AA-AC  Auto-Arrow or Auto-Circle for GPS posi�on 

  AD  Auto-Track Disable (for user scanned maps) 

  AL  Auto-show Waypoint Links (trip planning) 

  AM  Auto Map Move to follow GPS pos''n 

  AP *  Auto Pilot (toggle), for NatMap/UBD maps (Link  

  first) 

  AR  Auto-Recommend and Load maps (match   

  maps for current pos'n) 

  AW  Alert when approaching Waypoints 

  B  Birds-Eye View Display 

  C  Compass Display 

  D  Distances and ETA’s to Waypoints 

  Ctrl-D  Distance addi�onal measurement (Toggle) 

  EJ  Search for an Adjoining NatMap MapSheets map   

  (see also J) (suitable only for older MapSheets) 

  EL  Lock TrackRanger to only use current ECW   

  map (e.g. Australia’s Outback Tracks) 

  EP  Go back to Preview mode of the current ECW   

  map 

  ER  Auto Recommend and load NatMap MapSheets or   

  currently loaded Locked Map 

  EU  Use current ECW map view 

  FN  Force only NatMap (or UBD map) (toggle) (select  

  AutoPilot first) 

  G  GPS informa�on display 

  <Alt>G  Gaze4eer Place Name Search 

  Ctrl-G  Manually open Map GPS calibra�on dialog (for user   

  scanned maps) 

  H  Show Hot Keys (this command); 

  I  Informa�on Sta�s�cs 

  J  Search for Adjoining maps. See also EJ (suitable for   

  only for older Map Sheets products) 

  L  Link (Listen) to GPS (connect) - see also: <Esc> 

  Ctrl-L  Launch the Quick Lat/Long Calculator 
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M  Map Recommenda�on for current GPS posi�on  

N  Notepad for recording trip notes 

O  Open Map dialog (any map) 

P  Plot TrackTrace posi�on informa�on from  

  exis�ng file (Recorded first by using TrackTrace) (toggle) 

Ctrl-P  Plot addi�onal TrackTrace data (aGer first plot    

  has been drawn) - 3 plots max 

R  View Ruler Scale display 

Ctrl-R  Record a GPS Log File to disk (use ShiG-Escape to play it back) 

S  View Speedometer display 

Shi;-S  Startup preferences, Waypoint, TrackTrace, Plo-ng etc. 

Ctrl-S  View Satellite informa�on 

T  Track Trace Posi�on Informa�on + Logging 

Ctrl-T  Track Plan record a TrackTrace on the screen with the mouse 

U  Use alterna�ve 1:20k / 1:40k UBD maps (toggle) 

V  Night Vision (2 levels or Off) - Requires W2K or XP or later 

W  Waypoint Display for loaded Waypoints 

Ctrl-W  Open Waypoint management dialog 

X1-X7  Zoom  ECW Maps 

X9  Zoom ECW to User Defined Value (set from U�li�es menu) 

Z  Zoom 100% or force map refresh. 

<Space>   Show ID’s (names) for all Waypoint and Route posi�ons 

+ or =  Add current GPS loca�on as a Waypoint (= is instant) 

<Backspace>  Show Travel Sta�s�cs (Large Screen) 

Keyboard Arrow Keys  Scroll Map View on Screen (if Auto Map Move off) 

Shi; + PageUp/PageDown:  Zoom In / Out 

Shi; + ArrowKeys:   

  Navigate around map surface (useful for adjacent UBD area) 

Shi; + Le; Mouse BuIon:  Measure Distances using the mouse 

Shi; + Right Mouse BuIon: Measure Area (polygonal) 

Shi; + Le;-Click on a Waypoint: Zoom-In to Waypoint 

Shi; + <Alt> + Le;-Click on a Waypoint: Zoom-Out from Waypoint 

F12-F5  Recall a previous view extent of an ECW map (F12 is latest) 

<Esc>    Link to internal Demo GPS Data  

Shi;-<Esc>  Allows Alternate GPS log file to be loaded (see Control-R) 

  ','            (Comma) Pause reading of internal Demo GPS Data 

Shi;-Q   Stop reading Internal GPS recorded data 

(* Auto-Pilot for use with Natmap Raster or UBD street maps) 

Tip: Most commonly used keys are ‘L’ (Link) and ‘AP” (Auto-Pilot) 

Seldom used keys are grayed out 
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Installa�on / Opera�on Support inquiries should be sent to  

trackranger@advantechdesign.com.au 
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Only use Windows Control Panel > Add / Remove Pro-
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